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Introduction 
Welcome to the world of Financial Aid in PeopleSoft! 

 
This document has been created to assist you in navigating the first week/first month of working in 
PeopleSoft. 

 
Please feel free to save a copy to use while proceeding through your workday and let us know of 
any updates or how to make this better. 

Training  
Quick Reference Guides and Canvas Courses are available. Please review and learn about these 
two areas as much as you can before Go Live. It is also recommended that you explore the 
ctcLink Reference Center as your first resource for business process overviews and step-by-step 
instructions for processing in ctcLink.  

Immediate Go Live Support is available! 
During the first two weeks of Go Live, please visit our live support WebEx for immediate assistance. 
Information on the Go Live Support WebEx will be provided to you/your PM prior to Go Live. Each 
pillar has planned specific activities meant to orient you to your new world of processing in ctcLink. 
You may find some other sessions offered by our SF Support and CS Support teams valuable for 
you or any of your staff to attend. Explore your college’s ctcLink post go-live Activity Outline to view 
the support sessions planned for go-live for all ctcLink Pillars.  

Support Staff Contacts 

ctcLink Customer Support (FA) 
If you have any detailed questions, please contact the following support staff and we’ll be happy to 
assist.  In addition, you can email all of the PeopleSoft FA Support staff listed below by emailing 
fasupport@sbctc.edu. 

 
Staff Role Email 
Kelly Forsberg FA Support Training kforsberg@sbctc.edu 
Deborah Englehardt FA Functional Analyst denglehardt@sbctc.edu 
Stephanie Casino FA Senior Functional Analyst scasino@sbctc.edu 
Jedidiah Lara FA Functional Analyst jlara@sbctc.edu 
Britney Corbitt FA Functional Analyst bcorbitt@sbctc.edu 
Connie Burrow FA Functional Analyst cburrow@sbctc.edu 

Legacy Support 
Becky Phillips - FAS Product Manager 
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bphillips@sbctc.edu  
Please contact Becky Phillips for questions about Legacy processing and functionality while in Dual 
Processing. Our team will work closely with you and Becky to monitor file transmission and to 
answer questions about processing that crosses FAM and PS. 

Getting Started in ctcLink Financial Aid 

Getting to Know You 
FA Support would like to know your subject matter experts (SMEs) who will be responsible for each 
area of FA Processing. For example, who will be running and reviewing your Dual Processing Jobs? 
Who will be working with Student Financials for Disbursement? Once you are fully processing aid 
for your new aid year, it will be helpful to know who processes Pell, Loans, R2T4, SAP, 
Communications, State Grants, Authorization and Disbursement, etc. This will help monitor 
processes for your college and quickly work to resolve any problems.  

ctcLink Financial Aid Support Distribution List (eList aka 
Listserv) 
Join the listserv for timely announcements and tips! 
If you’re not already subscribed to the ctclinkfinaidsupport listserv, please subscribe-- and 
encourage your staff to subscribe—to the listserv so you don’t miss updated documentation 
announcements and other information from FASupport. ctclinkfinaidsupport list serv 

Ticketing System 
Submitting Support Tickets in SolarWinds 
Please note, upon conversion, in the ticketing system, your legacy account was closed and you will 
need to switch to the ctcLink.  This switch is easy, you will need to create a new Service Desk 
profile, using your ctcLink account.  Simply browse to https://servicedesk.sbctc.edu and log in with 
your ctcLink username (101XXXXXX) and password.  You will be prompted to fill in some info 
(email, phone, etc), and the system will create your account. 

 
After this is done, you can open a ticket with the SBCTC Helpdesk, and request that all of the 
tickets associated with your legacy account profile be switched to the new profile, and remove your 
old one.  Going forward, you will always log into the Service Desk with your ctcLink 
credentials.  
 
Help us help you! The FA Customer Support Team is committed to responding within one business 
day after submitting ALL the required information for your ticket. 
 
How to Submit a ctcLink Support Ticket  
  

Required information: 
●​ Describe the problem and steps you took 
●​ Provide the EMPLID of a student example  
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●​ Attach any files, screenshots and/or reports related to the issue 
●​ If process related, reference the processing guide/QRG used, the EMPLID of the staff who 

ran the process, navigation to the page used and screenshots of their Run Control ID 
parameters 

●​ Indicate any deviations from the global process 
 
During the two-week Support Live, we’ll be submitting tickets on your behalf related to Dual 
Processing setup and cleanup. 
 
So that we know who to assign the Dual Processing setup and cleanup tickets to, please submit a 
Dual Processing SMEs ticket.  
 
Request Type: ctcLink Support > Campus Solutions > Financial Aid > Dual Processing 
 
Subject: Dual Processing SMEs 
 
Request Detail: 
Financial Aid 
Main 
Name - EMPLID 
CC 
Name - EMPLID 
 
Student Financials 
Name - EMPLID 
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Dual Processing Run Control IDs and Security Quick 
Reference Document 
 

 

Security Roles Review 
 
In order to proceed smoothly through the Dual Processing Guide, having the proper security is 
important. Make sure to review each security area mentioned below before moving on. 

Query Security 
Confirm staff assigned to run Dual Processing have access to the following pages and queries. 
 
Page navigations: 

Nav Bar > Reporting Tools > Query > Query Viewer 
Nav Bar > Reporting Tools > Query > Schedule Queries 

 
Dual Processing queries: 

CTC_FA_I111_BIODEMO_VALIDATION 
CTC_FA_I121_SDNTENR_VALIDATION 
CTC_FA_I112_SDNTCAR_VALIDATION 
CTC_FA_I123_STDNDEG_VALIDATION 
CTC_DUAL_PROC_THIRD_PARTY_PMTS 
CTC_FA_CENSUS_EXTRACT_I113 
CTC_FA_DUAL_PROCESSING_WDRW 
QCS_FA_DUAL_PROCESSING_UNOFF_W 
CTC_FA_STDWRK_EXTRACT_I115 
CTC_FA_RECON_EXTRACT_I114 
CTC_FA_AIDYR_ACTIV_I118 
CTC_FA_SAP_I118 
CTC_FA_DUAL_PROCESSING_SAP_RPT 
CTC_FA_ACAD_PLAN_EPC 
QCS_FA_FAM_CROSSWALK_ITEMTYPE 
QCS_FA_FAM_CROSSWALK_ACADPLAN 
QCS_SF_ITM_TYPE_GL_INTERFACE  
CTC_SF_VAL_CHRG_PRI_BI 
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If you get, “No matching values were found,” when you search for a query, you are 
missing a role or record needed to access the query. 

 
Common roles FA users need to get access to the queries listed above: 
ZD_DS_QRY_FA_SSN_HIGHSENS 
ZD_DS_QRY_FINANCIAL_AID 
ZD_DS_QRY_STUDENT_FINANCE 
ZD_DS_QRY_STUDENT_RECORDS 

 
**Your local security team can run QCS_DS_QUERY_RECORD_USER_RPT query to figure out 
which roles/records you are missing in order to get access to a query you need**  

SACR Security 
For data validation and troubleshooting, it is helpful to have certain view-only roles in Student 
Records and Student Financials. We have listed pages that FA users commonly navigate to outside 
of Financial Aid. If you do not have access to any of the following pages, work with those areas to 
get the view-only roles assigned.  
 
Page navigation: 

Nav Bar > Set Up SACR > Product Related > Student Financials > Item Types  
Nav Bar > Curriculum Management > Course Catalog > Course Catalog 

Nav Bar > Records and Enrollment > Career and Program Information > Student 
Program/Plan 

 
Student Records security roles:  
ZD CM Course and Class Inquiry or ZD CM Course Catalog 
ZD SR Student Program​  
 
Student Financial security roles:  
ZD SACR SF Item Type Config 
ZD SACR SF All Config 

 
Set Up SACR and View Only Security References for Local Security Team 
 

Set Up SACR 
All ZD Security Roles View Only 

Service Indicator and Student Group Security 
Service Indicator and Student Group security is another area where you will want to work with 
Student Records and Student Financials to get view-only access to certain Service Indicators or 
Student Groups they put on students.  
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For Financial Aid, below is a list of globally used Financial Aid Service Indicators that your staff will 
need access to view/add/release. 

 
Page navigation:  
Nav Bar > Campus Community > Service Indicators > Person > Mass Assign  
 
Global Financial Aid Service Indicators 
​  

Service 
Indicator Code 

Description  Reason 
Code 

Description  

F01 FA Disbursement Hold FMULT Aid received at diff college 

FOWES Owes repayment on FA funds 

FPLAN Taking Courses not in 
AcadPlan 

NSLDS NSLDS Transfer Monitor Alert 

F02 Tuition Deferred-Possible 
FA 

FAPND Financial Aid Award Pending 

F03 FA Refund Hold DROP Dropped Units 

FATIV Repayment Calculation 

FENRL Change in enrollment status 

F04 FA Ineligible Academic 
Plan 

FIP Ineligible Acad Plan for FA 

F05 Financial Aid Repayment CBS Owes CBS Repayment 

FSEOG Owes FSEOG Repayment 

PASSF Owe PassportFosterYouth 
Repymt 

PASSI Owes Passport Incentive 
Repymt 

PELL Owes Pell Repayment 

PLUS Owes PLUS Repayment 
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SNG Owes SNG Repayment 

SUB Owes Subsidized Loan 
Repayment 

UNSUB Owes Unsubsidized Loan 
Repymnt 

F08 SULA Review SULAR SULA Review 

FLF Financial Aid Less than 
FT 

FALFT Less than Full Time Enrollment 

​  
Global Student Groups Commonly Financial Aid Users Request Access To 
​  

Student 
Group 

Description Short Description 

ROPG Opportunity Grant Opp Grant 

RPTC Passport to College Passport 

SAPR Apprenticeship Apprentice 

SBFT Basic Food, Employment & 
Train 

BFET 

SBST Intgrtd Basic Ed Skill Traing IBEST 

SEAG Early Achievers Grant EAG 

SEAP Student Emergency Assistance EmrgcyAsst 

SFCY Foster Care Youth FosterCare 

SINT International Student Intnl Stu 

SRSL Running Start Waiver RS Waiver 

SRSR Running Start RS Student 

SSEH Stds Experiencing 
Homelessness 

HomelesStu 

SVBA Chapter 30 MGIB Ch30 MGIB 
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SVBB Chapter 31 VR&E VR&E 

SVBC Chapter 32 VEAP VEAP 

SVBD Chapter 33 Post 9/11 Veterans 9/11 Vets 

SVBE Ch 33 Post 9/11 TOE Dep 
Child 

9/11 TOE C 

SVBF Chapter 35 Dependent Child Ch 35 DepC 

SVBG Chapter 1606 MGIB Ch1606MGIB 

SVBH Chapter 1607 REAP REAP 

SVBJ Active Duty TA Active TA 

SVBK Active Duty Military Benefits Active Ben 

SVBL Active Duty Dependent 
Benefits 

Act Dp Ben 

SVBM Ch 33 Post 9/11 TOE Elg 
Spouse 

9/11 TOE S 

SVBN Chapter 35 Eligible Spouse Ch 35 ElgS 

SVBP All Other Veterans w/Ben Othr VwBen 

SVBV VRAP VRAP 

SVBZ All Other Veterans No Ben Othr VnoBn 

SVET Veteran Information ReqVetInfo 

SWRF WorkFirst WorkFirst 

SWRT Worker Retraining WrkrRetrng 

 
Service Indicator and Student Group Security QRGs for Local Security Team 

 
SACR Security Service Indicator Security 
Student Group Security 
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Dual Processing Security 
In order to complete the steps for Dual Processing, there are some security roles that Financial Aid 
and Student Financials staff need to have assigned to their EMPL ID. Below are the navigations as 
well as the roles to be assigned. 
 
Financial Aid Roles: 

Nav Bar > PeopleTools > CTC Custom > Extensions > Upload/Download Files 
ZZ_FA_UPLOAD_DOWNLOAD 

Nav Bar > Campus Community > CTC Custom > CTC Query Reporting Table 
ZZ_CC_QRY_RPT_TBL 

Nav Bar > Financial Aid > CTC Custom > CTC Interfaces > FAM > FAM 
ZZ_FINANCIAL_AID_MANAGEMENT 

 

Student Financials Role: 

Nav Bar > Financial Aid > CTC Custom > CTC Interfaces > FAM > FAM Disbursement Data 
Process 

ZZ_FINANCIAL_AID_DISBURSEMENT 

 

Note: It is not recommended for a staff person to have access to both the FAM page as well 
as the FAM Disbursement Data Process page  

 
Additional Security References for Local Security Team 

 
Security Access to Student Service Tabs 
All ZZ Security Roles Processor 

Dual Processing Overview 
Dual Processing was created to allow Financial Aid users to finish their current Aid Year processing 
in the Legacy system after PeopleSoft go live.  This solution allows users the ease of continuing 
Financial Aid processing without converting over live data.  Users will finish processing in Legacy 
while preparing for the upcoming Aid Year in the PeopleSoft system.   

Recommendations for successful processing 
It is highly recommended that you review the Dual Processing Business Process Guide end-to-end. 
Plan to have the guide available at all times while processing for a quick reference.  
 

●​ Plan your desired processing schedule, i.e. How often do you want to Disburse?  Daily?  
Tuesdays and Thursdays only?  Your other processes will need to be coordinated around 
your desired processing schedule.  
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●​ Set up your Dual Processing Jobset to run outbound processes automatically. DG6 
Colleges will complete this work together during the go-live support session with the 
help of ctcLink and Legacy Support Teams. 

●​ Review your Legacy side processing and reports that will be run as part of Dual Processing. 
●​ Ensure that you are running your PS INBOUND processes that are required to process 

disbursements, SAP, and reconciliation -- in addition to your PS OUTBOUND processes. 
●​ Coordinate your refund schedule with your SF/Business Office responsible staff. Ensure that 

this staff has the proper security access to execute these processes. 
Preparing for Disbursements 

●​ It is critical that you do not initiate disbursements before FA Support and SF Support inform 
your office that any conversion clean up needed after go live is complete.  

●​ Please inform FA Support and your SF staff of your target first disbursement date after 
go-live so that the process can be coordinated.  

●​ There are business process changes at go live which are covered in detail in the Dual 
Processing Business Process Guide, among them are disbursing from FAM while in Dual 
Processing and Disbursing when you are fully in PeopleSoft. 

●​ Due to the need for Separation of Duties, your SF staff will run the Dual Processing 
disbursement process in PS. Please see the QRG below for an overview of these steps. 
There are related security roles needed to run this process: 
9.2 FAM Disbursement Data Process (Post) 

Set Up Dual Processing Jobs 
Dual Processing jobsets will be built together during the go live webex with support from ctcLink FA 
Support and the Legacy FAS Product Manager.  

Critical Notes about Dual Processing & Legacy Systems 
Dual Processing actually means much more than disbursing using FAM and PS.  The other jobs do 
need to run daily so you can continue to process aid in FAM.   
 
While in Dual Processing you’ll use data from PS instead of from SMS.  One example is the 
program information that is needed to create loan and Pell records for COD reporting.  Now that you 
are in Dual Processing that program data will derive from PS instead of SMS, and will be continued 
to report out of FAM. 
 
After you have reviewed the crosswalk data and have returned any changes to SBCTC FA Support, 
the Dual Processing jobs can be set up. FA Support and Legacy Support will coordinate the best 
time to schedule the automated jobs needed for processing after your jobset run controls are 
created by your designated staff.  
 
Timing of the jobs is important.  The PS processes that create the four extract files need to be 
scheduled to run at least an hour before the corresponding HPUX batch job group (AG995R) is 
scheduled.  These also need to be scheduled to run on a daily basis (Monday through Friday).  The 
best time to run these processes is late evening depending on when your HPUX system goes into 
Production mode.  Any other HPUX batch jobs can run after the AG995R has posted the PS data to 
the cloned databases on the HPUX. 
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Scheduling CTCFADP & HPUX Jobs 
Here’s an example of the scheduling: 
 
NOTE:  the times at your colleges may be different 
 
10:00 PM – PS job set to create the 4 extract files 
 Axway picks up the files and moves them to the HPUX 
 
11:00 PM – P110 HPUX goes into Production Mode 
Process Level A - AG995R launches and posts the data from the 4 files into the cloned databases. 
Process Level B – KW5001J launches and creates the file of rollover track codes.  Files is sent to 
PS via Axway 
Process Level C through Process Level _ – other legacy HPUX batch jobs used to process financial 
aid.  
 
The following are typically scheduled by a college to process financial aid but there are many more 
you might typically schedule.  All should be scheduled in their own Process Level in Production: 
 
SM9108J – (Finaid Bio Update from SMS) 
AG905R – (Preliminary Check Calc) 
SM9110J – (Finaid Academic Attempted Hours Update) – one instance for every quarter at different 
Process Levels 
SM9111J – (FAS Academic Enrolled Program Data Update) – one instance for every quarter at 
different Process Levels 
 
You can find the list of HPUX Batch jobs available while in Dual Processing in the BPG. 

Recommendations for FAM Disbursement 
We do recommend that you run the Preliminary Check Calc job group (AG905R) on a daily basis.  
After reviewing the reports from AG905R and when you are ready to create a disbursement file, you 
will schedule AG996R.  This job group can be run as frequently as you need; however, since you 
cannot pull back any disbursements once AG996R creates the disbursement file it is important to 
review the reports from the preliminary job group first to ensure all records are valid. Please 
coordinate with your SF staff who will be running the PeopleSoft Disbursement and Refund 
Processes before processing disbursements.  

Other Recommendations for Disbursement 
Run the Disbursement job one batch at a time.  Wait for it to Post to SF before running the next 
batch Disbursement. Review the outcome of each batch by viewing the Process Monitor and the log 
that is attached to each process before running the next disbursement job. Detailed instructions are 
provided in the Dual Processing Business Process Guide under the Disbursement (PeopleSoft) 
section. The example in the screenshot below indicates a missing FAPC. Should this occur, please 
open a ticket with FA Support to correct your crosswalk values.  

Updated: May 9, 2022 
SBCTC/ctcLink FA 

13 
 



 

​

 
 

Dual Processing Known Issues 

Incorrect/Missing Crosswalk Dual Processing 
Dual Processing Outbound and Inbound processing utilizes crosswalk values to translate 
PeopleSoft data to corresponding Legacy data and vice-versa. 

FA Support will open tickets for each college and provide a current list of these values at Go Live. 
You will have an opportunity to review these values and correct any incorrect or missing values. 

 Why this is important 
●​ You will not be able to disburse to students that do not get successfully processed through 

Dual Processing. 
●​ You will have manual disbursement cleanup to do if FAPCs are not cross walked correctly. 

Student Worker Payroll Extract 
You may see changes in the total earnings depending on when you run the process. For example, 
you may run the process in January to get total Fall Quarter earnings, but the process is tied to an 
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HR table that has a delay so you will want to look at the Fall Quarter numbers again when you run it 
in February. 

Award Sub Codes 
Dual Processing is not designed to handle enrollment levels as award sub codes. If you will be 
using Award Sub Codes to track enrollment levels during Dual Processing, submit a ticket to FA 
ERP Support because the reconciliation file will need manual manipulation. 

Processing Census 
Contrary to the word “Census” in the name of the process, it is not a process that should be run only 
once after Census. This is a process you will fun frequently.  

Students Not Enrolled 
Although there is an override currently to use on the Legacy side, it is recommended that you  
become familiar with the Processing Disbursements for Students with No Enrollment on PS Side 
steps in the Dual Processing Guide. 

WASFA Students/Students with No SSN 
There are a few workarounds and the workaround you choose will depend on how your college 
decides to code the FAM, SMS records. Keep a list of records you are using these workarounds on 
so that they can be updated at a later time to include an actual ITIN (if available) and a row with an 
SSN of all XXX’s can be added back when the student’s aid applications will be fully processed in 
PS.  

​ Workaround 1 
​ If you are using the Legacy SID as the SSN and ITIN in FAM, have Records and Enrollment add 

a row for an ITIN National ID Type. Then have them list the Legacy SID as the ITIN number. 
Finally, make the ITIN the “flagged” primary National ID. Ensure there is no SSN row with XXX’s 
on the Add/Update Person Screen. If there is, delete it.  
​ Workaround 2 
​If you are using the EMPLID as the SSN and ITIN in FAM, have Records and Enrollment add a 
row for an ITIN National ID Type in PS. Then have them list the EMPLID as the ITIN number. 
Finally, make the ITIN the “flagged” primary National ID.  Ensure there is no SSN row with 
XXX’s on the Add/Update Person Screen. If there is, delete it.  
 

Nightly Jobs 
There may be times when you come in in the morning and notice that your Dual Processing ran to 
Error or No Success. We have seen Dual Processing jobs run unsuccessfully because a previous 
job in the queue did not finish running by a certain time or there is some data PS is unable to 
process. Becky and FA ERP Support will work with you to troubleshoot the issue and get jobs set 
back on the recurrence again. 
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Dual Processing Crosswalk Review 
FA Support has created tickets for review and approval of your crosswalk values for Dual 
Processing. Errors in these values may not be apparent until you are running your Dual Processing 
validation extracts and your preliminary check calc process.  
We will be reviewing these more together during our crosswalk review session on day two of the 
go-live support webex and on the days beyond. These crosswalks should be reviewed before 
planning to process a LIVE disbursement via Dual Processing.   
 
FA Go Live Crosswalk Review 

SAP Configuration Review 
Before you can run SAP, FA Support must finalize your SAP Configuration, or results will not be 
accurate. FA Support staff will open a ticket for you to review Remedial Course values that should 
be excluded from SAP calculations.  You must review these Remedial Course Values to verify they 
are courses you wish to exclude from the SAP calculation’s “max attempted units” test. 
To better understand how these values are used in PeopleSoft SAP Processing, review the SAP 
Processing Guide (SAP Setup pp. 1–28) 
 
SBCTC will run a script that should list all of your remedial coursework.  The results will be attached 
to a ticket for your review.  Below is a snapshot of what the output may look like. 
 

 
 
The courses in this list should be eligible for exclusion when determining a student’s maximum 
timeframe, up to a limit set by the institution (typically 45 credits).  If a course is NOT in this list, it 
will always count towards max timeframe.** 
 
You can indicate missing courses in a ticket, which will be created for you. 
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**Exception:  ABE will never count towards max timeframe if courses are configured correctly.  
Please review your ABE courses on the Course Catalog page (Nav > Curriculum Management > 
Course Catalog > Course Catalog). 
 
Reviewing ABE Courses 
 
The remedial course list will not exclude ABE courses from SAP correctly.  To ensure that ABE 
courses are treated properly by the SAP calculation, verify that your ABE courses are using the 
correct grading basis.  You can view this on the Course Catalog page. 
 

 
 

The grading basis should be BEdA for ABE courses.  To view all of your ABE courses at a glance, 
you can run the query QCS_CM_BASICSKILLS_GRADEBASIS.   
 
If you don’t have access to the Course Catalog page or the query, please contact your security 
team. 

Bank Mobile Review  
Below is a general overview of the tasks that take place prior to and at go-live to transition to 
processing for Bank Mobile now that you are on PeopleSoft. FA Support will work with you to keep 
you informed on the progress of the transition and will also reach out to you for approval of test and 
live files during this transition period.  
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Process  Responsible Party  Description  Coordination  
File Transfer Set Up  Bank Mobile & 

SBCTC Server Team  
Set up of new account 
security keys(?)  

SBCTC’s Jim H and Bank 
Mobile 

Conversion List  Bank Mobile  

  

Sends Project conversion 
list of existing active 
student data  

Server team assisting 
with file transfer  

Conversion Files  Bhuvana/Project  Project returns files with 
converted data to be 
validated  

  

Server team assisting 
with file transfer  

Turn Off Auto-Send of 
Enrollment Files  

SBCTC Data 
Services  

At some point, SBCTC 
needs to turn off the 
automated process for 
sending Enrollment Files 
and update with the new ID 
format.  

  

SBCTC Data Services  

Bank Mobile Ready 
for Test Files   

Bank Mobile & 
SBCTC Server Team  

Bank Mobile approves 
conversion; requests one 
of each file type before 
turning directories back on  

SBCTC’s Jim H and Bank 
Mobile  

First Enrollment File 
sent  

SBCTC Data 
Services  

Data services sends first 
enrollment file; BM 
confirms valid format. BM 
gives greenlight to enable 
auto-transfer.   

Steven Marx – coordinate 
via email; Support will 
open a ticket for each 
DG  

First Test File - Demo 
file  

Support with colleges  

  

Bank Mobile Student Data 
process generates file. 
College affirms file is good 
to process via email with 
BM.  

Server team assisting 
with test file transfer. BM 
emails all and waits for 
college response. Gives 
greenlight to enable 
auto-transfer.  

  
First Test File – 
Refund file  

Support with colleges  

  

Bank Mobile Refunds 
process generates file  

Server team assisting 
with test file transfer.   

BM emails all and waits 
for college response. 
Gives greenlight to 
enable auto-transfer.  
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http://ctclinkreferencecenter.ctclink.us/m/92558/l/797525-9-2-bankmobile-student-data
http://ctclinkreferencecenter.ctclink.us/m/92558/l/1018725-9-2-bankmobile-batch-refunds


 

(SBCTC’s Jim H and 
Bank Mobile’s Amy 
Duong/Jack DePalma)  

  
 

Other Tips & Resources 

Dual Processing Guide 
Financial Aid Dual Processing Business Processing Guide 

BankMobile Student Data Process (for BankMobile colleges) 
(Biodemo data sent to BM) 
BankMobile Student Data 

FAM Disbursement Processing 
FAM Disbursement Data Process Posting 

Data Validation 
Data Validation Financial Aid Draft Presentation 

Reporting Tools 
●​ A PeopleSoft Query is a tool that extracts institutional information from a database and displays 

that data via Excel, HTML, or XML. These queries are also used to identify and track student 
data (and financial accounts) so that the database can operate as intended.  

●​ Please consider taking part in the ctcLink PS Query Development training Materials and 
Courses to learn more about this invaluable tool. 
○​ Most Used and Favorite Queries 
○​ CS Pillar Specific Queries 
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http://ctclinkreferencecenter.ctclink.us/m/92436/l/1122042-financial-aid-dual-processing-business-processing-guide
http://ctclinkreferencecenter.ctclink.us/m/92558/l/797525-9-2-bankmobile-student-data
http://ctclinkreferencecenter.ctclink.us/m/92558/l/1240601-9-2-fam-disbursement-data-process-posting
http://ctclinkreferencecenter.ctclink.us/m/97418/l/1264663-cs-data-validation-financial-aid-draft-presentation-friday-6-19
http://ctclinkreferencecenter.ctclink.us/m/92912/c/311995
http://ctclinkreferencecenter.ctclink.us/m/92912/l/1173599-most-used-and-favorite-queries
https://docs.google.com/document/d/1KZOphoiQddqxC02atg2qroBAriUXzZWqq3Pu5uz7pk8/edit#heading=h.jz7ue3oqii6
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